Chat

Chat Activities

What is the Chat Tool?

The Chat tool allows you to have real-time conversations with participants of your course. It
can be used for online, interactive sessions such as office hours, question and answer
discussions, and guest speakers. The Chat tool contains both chat rooms and whiteboard rooms
that you can make available to your students.

IMPORTANT: Click the Teach tab before you use the Chat tool in your WebCT courses—this is the place
instructors can communicate with students, teaching assistants and other instructors in the course.

Chat Settings

Chat Tools

Title Value

Enable Chat tool * @ trua £ o false
Allow Teaching Assistants to view and clear ) true i & false
chat logs *

Lugginé is on by default in hewly created chat @ true / () false
rooms *

Allow Students to view chat logs * () true f’@ false
allow Auditors to view chat logs ™ (O trua £ ® false
Allow Teaching Assistants to create rooms * ) true 7 & false

| Save Values | Cancel

*Required fields
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Chat Tools settings

Enable Chat tool Adds the Chat tool to your course if the value is
set to true.

Allow Teaching Assistants to | Allows you to globally configure whether or not

view and clear chat logs to allow TAs to view and delete the chat logs.

Logging is on by default in Allows you to globally configure whether or not

newly created chat rooms to log messages in newly created chat rooms.

Allow Students to view chat | Allows you to globally configure whether or not

logs to allow students to view the chat logs.

Allow Auditors to view chat | Allows you to globally configure whether or not

logs to allow auditors to view the chat logs.

Allow Teaching Assistants to | Allows you to globally configure whether or not

create rooms to allow TAs to create new chat rooms.

Follow these steps to view or edit the Chat tool settings.
1. Click the Build or Teach tab.
2. Click Manage Course from the Designer Tools area (Instructor Tools area on the
Teach tab); then click Settings; and finally click Chat.
3. Make your changes to the Chat tool settings and click Save Values to save your changes.
Otherwise click Cancel to not save your changes.

Accessing Chat

To use a chat or whiteboard room, you and/or your students must have a pre-designated time in
which to meet via this medium. When you click the room name you are automatically connected
with others who are online in the same room.

1. Click the Teach tab.

2. Click the Chat button ‘@ It |or icon on the Course Tools menu.
When you enter the Chat tool the main screen appears.

| create chat or Whiteboard Room |

:r] Common Room 2
(2 participants inside)

Group 1 ¥
(1 participants inside)

<

Group 2
(0 participants inside)

4 4

Group 3 =
(0 participants inside)

0

Office Hours %

U

(0 participants inside)
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3. Click the name of the chat or whiteboard room that you wish to enter. The chat room
window displays. The following example illustrates a sample room with both chat and
whiteboard areas.

[ Common Room 4] | Group 1
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Java Applet Window

The Chat Window

Room name Each tab displays the name of the room. You can click the tab to
display the information for that room.

Whiteboard area | This is the interactive area where you and/or your students can
create and edit drawings, and load files to share.

Hide Hides or shows the whiteboard area and its tools.

Whiteboard /

Show

Whiteboard

Load File Allows you to load an image file into the whiteboard area. Valid
files types are gif, jpg, jpeg.

Save Allows you to save the contents of the whiteboard area.

Print Allows you to display the entire contents of the whiteboard area
in a new browser window where you can print it.

Slide Shows Allows you to create, edit, and load a series of images (a slide

show) inside the whiteboard area. You control the display of each
slide displayed to the students.

Hide Chat / Hides or shows the chat area and its tools.
Show Chat
Chat area Displays messages sent by users. Each message displays the user
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name and the content of the user message.

Message area

Text box where you can type your message to send.

Send

Sends the message you typed in the message area.

g Allows you to set the preferences for chimes in the chat room.
Start Handraise | Allows you to stop the sending of chat messages by participants
Mode / Stop to the chat room. If selected, your participants need to click the
Handraise Raise Your Hand button in their chat room to get your attention.
Mode You can then start a private chat with that participant, or stop the

handraise mode.

Participant list

Shows the name of every user logged on to this chat room.

Pass
Microphone/Pen

Allows you to pass control to a participant.

Mute / Unmute

Allows you to mute an individual participant—blocking
participation in the room. You must first click the name of the
participant name and then click Mute. To allow the participant to
be active in the room again, click the name and then click
Unmute.

Deny Access /
Grant Access

Allows you to deny access to a participant so that individual can
no longer participate in the room. You must first click the name
of the participant and then click Deny Access. To allow the
participant to be active in the room again, click the name and then
click Grant Access.

Close window

Exits the room and closes the window.
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Creating Chat or Whiteboard Rooms

You can use chat and whiteboard rooms as a way to communicate with the entire class, as a work
area for student groups, or as a way to facilitate and organize live discussions in your course.

1.
2.
3.

o

Click the Teach tab, and then the Chat button or icon.

From the main Chat page, click Create Chat or Whiteboard Room.

Type the name of your new chat or whiteboard room. Optionally, you may type a
description to aid students in understanding the nature of the room and whether or not
you want the room to be hidden (not shown) to the students at this time.

Create Chat or whiteboard Room
*Title:

Diescription:

[ use HTML
[tem VYisibility: & Show Item

O Hide Item
*Masimum ' | Maximum users allowed by Server
LSErs: &dministrator is 1,000

In the Type section, select whether this room includes a Chat and Whiteboard, Chat only,
or Whiteboard only.

Type
@ Chat and Whiteboard

(T Chat anly

(yWhiteboard only

Click More Options to expand this section.

In the User Permissions section, select the check boxes according to your preferences to
allow users to hide or show the chat or whiteboard areas, allow private chat messages and
allow alias. Note: Private chat messages are NOT logged.

User Permissions
[JAllow users to hide: or show Chat or Whiteboard in a combined room

[JAllow private Chat messages

[allow alias
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7. Inthe Enable logging section, clear (uncheck) the check box if you DO NOT want to
maintain a chat room log. By default, the system keeps a log of activity in this chat
room. Note: Private chat messages are NOT logged.

Enable logging
[ Maintain Chat room log

| Ssave | | cancel | : | Save and Create Another |

8. Click Save. The new chat or whiteboard room is now added.

Reordering Chat or Whiteboard Rooms

1. Click the Build tab, and then the Chat button or icon.
2. Click the check box next to one or more chat or whiteboard rooms that you want to move.

3. Click the move button £ to display the menu options.

«F Move Selected above

AL Mowve Selected Below

4. Select an option from the Move menu. The chat or whiteboard rooms are reordered.

Editing Room Properties

In your course, you change chat room properties to reflect current information, or to announce
changes in the use of these rooms.

1. Click the Teach tab, and then the Chat button or icon.

2. From the main Chat page, click the ActionLinks button next to the room name you want

to edit.

3. Select Edit Properties.

4. Make the necessary changes to your room properties.

5. Click Save to save your changes.

Accessing Chat Logs

WebCT can generate a text record of everything written in chat rooms, except private messages.
By default, all chat rooms are set to log all entries—you can turn off this setting when you create
a room or edit room properties.

Click the Teach tab, and then the Chat button or icon from the Course Tools menu.
On the main Chat screen, click the ActionLinks button next to a chat room name.
Select View log from the menu.

You may select the Clear Log button to delete the log for that chat room.

AwnhE
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Saving Chat Logs

Once your chat room has generated a chat log on the screen (it shows all persons chatting, the
order of their comments, and their actual typing), you can copy and paste the log into a word-
processing program to edit and/or print.

Click the Teach tab, and then the Chat button or icon.

On the main Chat screen, click the ActionLinks button next to a chat room name.

Select View log from the menu.

Using your mouse pointer, highlight all of the text from your Chat log that you wish to

copy.

From the Edit menu in your browser, select Copy.

From your desktop, open a blank document in a word-processing application like

Microsoft Word, NotePad, or SimpleText.

7. From the Edit menu in the word-processing program, select Paste. The text from your
chat log will appear in your new document.

8. From the File menu, select Save. Give the document an appropriate file name, and save it

in an appropriate location.

AwnhE
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Creating Links to Rooms
You can easily add a link to a chat or whiteboard room to any Folder or Learning Module from
either the:

e Folder or Learning Module

e Chat tool.

From a Folder or Content Module
1. Click the Build tab, and navigate to the Folder or Learning Module where you want to
add a link.
2. Click Add Content Link.
3. Select Chat from the menu.

D) Add Content Link~ |

(@] Assessments »
égj Assighments. »
@ Chat »

i Discussions »
Learning Madule »
@ Web Link »
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4. From the expanded menu select the room.
You can select more than one item if you click
CTRL+click (CMD+click on a Mac) each
item.

Note: If you need to create a new room that is
not in the list, click Create Chat Whiteboard
Room. You can then follow the steps in the
previous section of this document, titled
‘Creating Chat or Whiteboard Rooms’.

5. Click Add Selected.

From the Chat Tool

fissessments

&) Assignments »

@ Chat =

[

| Create Chat j
Whiteboard Room

Select from inventory:

Coammorn BEoom s
Group 1

Group 2

Group 3

Office Hours

| Add Selected |

5@ Discussions »
@* Learning Module. s
gl Web Link »

1. Click the Build tab, and then the Chat button or icon.
2. From the main Chat page, select the check box next to a room. You can mark more than

one room.

3. Select a folder or learning module from the Create Link on list.

M Create Link an: |

; Sele
Foldars

Course Content Home

tModules

Helpful Links

Tools
Learning Modulas

bodule 1 & 2 Request Acco..,
bodule 3 & 4 Edit, Prewvie...
Module & & B Upload Wiew ..

4. Click Go next to the list. A message at the top of the page confirms the rooms that

were added to that Folder or Learning Module.
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Deleting Rooms

1. Click the Teach tab, and then the Chat button or icon from the Course Tools menu.

2. From the main Chat page, click the ActionLinks button next to the name of the room to
remove, and then select Delete.

3. When the warning message appears, click OK to delete the room.

Academic Technology Services



	Chat Activities 
	What is the Chat Tool? 
	Chat Settings 
	Accessing Chat 
	 Creating Chat or Whiteboard Rooms 
	Reordering Chat or Whiteboard Rooms 
	Editing Room Properties 
	Accessing Chat Logs 
	Saving Chat Logs 
	Creating Links to Rooms 
	From a Folder or Content Module 
	From the Chat Tool 

	Deleting Rooms 


